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13.1 Overview

The plot package provides classes, applets, and applications for two-dimensional graphical display
of data. It isavailablein a stand-alone distribution, or as part of the Ptolemy Il system.

There are several ways to use the classes in the plot package:

* You can use one of several domain-polymorphic actorsin a Ptolemy |1 model to plot datathat is
provided as an input to the actor.

* You caninvoke an executable, pt pl ot , which isashell script, to plot datain alocal file or on the
network (viaaURL).

* You can invoke an executable, hi st ogr am which isa shell script, to plot histograms of datain a
local file or on the network (viaa URL)

* You can invoke an executable, pxgr aph, which isa shell script, to plot datathat is stored in an
ascii or binary format compatible with the older program pxgr aph, which is an extension of
David Harrison's xgr aph.

* You can invoke a Java application, such as PlotMLApplication, by using thej ava program that is
included in your Javadistribution.

* You can use an existing applet class, such as PlotMLApplet, in an HTML file. The applet parame-
ter dat aur | specifiesthe source of plot data. You do not even have to have Ptplot installed on
your server, since you can always reference the Berkeley installation.

* You can create new classes derived from applet, frame, or application classes to customize your
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plots. Thisallowsyou to completely control the placement of plots on the screen, and to write Java
code that defines the data to be plotted.

The plot data can be specified in any of three dataformats:

e PlotML isan XML extension for plot data. Its syntax is similar to that of HTML. XML (extensible
markup language) is an internet language that is growing rapidly in popularity.

e Anolder, smpler textual syntax for plot datais aso provided, although in the long term, that syn-
tax is unlikely to be maintained (it will not necessarily be expanded to support new features). For
simple data plots, however, it is adequate. Using it for applets has the advantage of making it pos-
sible to reference a dightly smaller jar file containing the code, which makes for more responsive
applets. Also, the datafiles are somewhat smaller.

» A binary file format used by pxgr aph, is supported by classes in the compat package. Formatting
information in pxgr aph (and in the compat package) is provided by command-line arguments,
rather than being included with the binary plot data, exactly asin the older program. Applets spec-
ify these command-line arguments as an applet parameter (pxgraphargs).

13.2 Using Plots

If $PTII represents the home directory of your Ptplot installation (or your Ptolemy 1l installation),
then, $PTl1/bin isadirectory that contains a number of executables. Three of these invoke plot applica
tions, pt pl ot, hi st ogram and pxgr aph. We recommend putting this directory into your path so
that these executables can be found automatically from the command line. Invoking the command

pt pl ot

with no arguments should open awindow that looks like that in figure 13.1. You can also specify afile
to plot as a command-line argument. To find out about command-line options, type

ptpl ot -help
The ptplot command is ashell script that invokes the following equivalent command:

java -classpath $PTII ptol eny.plot.plotnl . Editabl ePl ot MLAppl i cation

Since it is a shell script, it will work on Unix machines and Windows machines that have Cygwin®
installed. In the same directory are three Windows versions that do not require Cygwin, pt pl ot . bat,
hi st ogr am bat, and pxgr aph. bat, which you can invoke by typing into the DOS command
prompt, for example,

pt pl ot . bat

1. Thel.1.x version of the Cygwin Toolkit is afreely available package available from
http://sources.redhat.com/cygwin/
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These scripts make three assumptions.

e Firgt,j avaisinyour path. Type“j ava - versi on” to verify that thej ava programisin your
path and is working properly

e Second, the environment variable PTII is set to point to the home directory of the plot (or Ptolemy
Il) installation. Type “echo %PTI 1 % in aWindows DOS shell and “echo $PTI | ” in Unix or
Windows Cygwin bash shell to check this.

e Thedirectory $PTII/binisin your path. Under Windows without Cygwin, type “echo %PATHY% .
Type“type pt pl ot ” in Windows with Cygwin and “whi ch pt pl ot ” in Unix to check this.

In Windows, environment variables and your path are set in the System control panel. You can now

explore a number of features of ptplot.

13.2.1 Zooming and filling

To zoom in, drag the left mouse button down and to the right to draw a box around an area that you
want to see in detail, as shown in figure 13.2. To zoom out, drag the left mouse button up and to the
right. To just fill the drawing area with the available data, type Control-F, or invoke the fill command
from the Special menu. In applets, since there is no menu, the fill command is (optionally) made avail-
able as a button at the upper right of the plot.

13.2.2 Printing and exporting

The File menu includes a Print and Export command. The Print command works as you expect.
The export command produces an encapsulated PostScript file (EPS) suitable for inclusion in word
processors. Theimage in figure 13.3 is such an EPS file imported into FrameM aker.

At this time, the EPS file does not include preview data. This can make it somewhat awkward to
work with in a word processor, since it will not be displayed by the word processor while editing (it
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FIGURE 13.1. Result of invoking ptplot on the command line with no arguments.
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will, however, print correctly). It is easy to add the preview data using the freely available program
Ghostview?. Just open the file using Ghostview and, under the edit menu, select “Add EPS Preview.”

Export facilities are also available from a small set of key bindings, which permits them to be
invoked from applets (which have no menu bar) and from the standalone scripts:
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FIGURE 13.2. To zoom in, drag the left mouse button down and to the right to draw abox around the region
you wish to see in more detail.

1. Ghostview is available http://www.cs.wisc.edu/~ghost
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Control-c: Export the plot to the clipboard.

D: Dump the plot to standard output.

E: Export the plot to standard output in EPS format.

F: Fill the plot.

* Hor? Display asimple help message.

The encapsulated PostScript (EPS) that is produced is tuned for black-and-white printers. In the
future, more formats may supported. Also at thistime (JDK 1.3.0 under Windows 2000), Javas inter-
face the clipboard may not work, so Control-C might not accomplish anything. Note further that with
applets, you may find it best to click near the title rather than clicking inside the graph itself and then
type the command.

Exporting to the clipboard and to standard output, in theory, is allowed for applets, unlike writing
to afile. Thus, these key bindings provide a simple mechanism to obtain a high-resolution image of the
plot from an applet, suitable for incorporation in a document. However, in some browsers, exporting to
standard out triggers a security violation. You can use Sun's appletviewer instead.

13.2.3 Editingthe data

You can modify the data that is plotted by first selecting a data set to modify using the Edit menu,
then dragging the right mouse button. Figure 13.4 shows the result of modifying one of the datasets
(the onein red on a color display). The modification is carried out by freehand drawing, although con-
siderable precision is possible by zooming in. Use the Save or SaveAs command in the File menu to
save the modified plot (in PlotML format).
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FIGURE 13.3. Encapsulated postscript generated by the Export command in the File menu of ptplot can be
imported into word processors. This figure was imported into FrameM aker.
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13.2.4 Modifying the format

You can control how data is displayed by invoking the Format command in the Edit menu. This
brings up adiaog like that at bottom in figure 13.5. At the left isthe dialog and the plot before changes
are made, and at theright is after changes are made. In particular, the grid has been removed, the stems
have been removed, the lines connecting the data points have been removed, the data points have been
rendered with points, and the color has been removed. Use the Save or SaveAs command in the File
menu to save the modified plot (in PlotML format). More sophisticated control over the plot can be
had by editing the PlotML file (whichisatext file). The PlotML syntax is described below.

The entriesin the format dialog are all straightforward to use except the “X Ticks” and “Y Ticks”
entries. These are used to specify how the axes are labeled. The tick marks for the axes are usually
computed automatically from the ranges of the data. Every attempt is made to choose reasonable posi-
tions for the tick marks regardless of the data ranges (powers of ten multiplied by 1, 2, or 5 are used).
To change what tick marks are included and how they are labeled, enter into the “X Ticks’ or “Y
Ticks” entry boxes a string of the following form:

| abel position, |abel position,

A label isastring that must be surrounded by quotation marksiif it contains any spaces. A positionisa
number giving the location of the tick mark along the axis. For example, a horizontal axis for a fre-
guency domain plot might have tick marks as follows:

[E: Prolemy plot -0 x|

File | Edit | Special
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value
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@ Choose a data set, then drag the right mouse button: m

Ol Cancel
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FIGURE 13.4. You can modify the data being plotted by selecting a data set and then dragging the right
mouse button. Use the Edit menu to select a data set. Use the Save command in the File menu to save the
modified plot (in PlotML format).
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XTicks: -Pl -3.14159, -PI/2 -1.570795, 0 O, PI/2 1.570795, Pl 3.14159

Tick marks could also denote years, months, days of the week, etc.

13.3 Class Sructure

The plot package has two subpackages, plotml and compat. The core package, plot, contains tool-
kit classes, which are used in Java programs as building blocks. The two subpackages contain classes
that are usable by an end-user (vs. a programmer).
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FIGURE 13.5. You can control how datais displayed using the Format command in the Edit menu, which
brings up the dialog shown at the right. On the top is before changes are made, and on the bottom is after.
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13.3.1 Toolkit classes

The class diagram for the core of the plot package is shown in figure 13.6. These classes provide a
toolkit for constructing plotting applications and applets. The base classis PlotBox, which renders the
axes and thettitle. It extends Panel, abasic container classin Java. Consequently, plots can be incorpo-
rated into virtually any Java-based user interface.

The Plot class extends PlotBox with data sets, which are collections of instances of PlotPoint. The
EditablePlot class extends this further by adding the ability to modify data sets.

Live (animated) data plots are supported by the PlotLive class. This class is abstract; a derived
class must be created to generate the data to plot (or collect it from some other application).

The Histogram class extends PlotBox rather than Plot because many of the facilities of Plot are
irrelevant. This class computes and displays a histogram from a data file. The same data file can be
read by this class and the other plot classes, so you can plot both the histogram and the raw datathat is
used to generate it from the samefile.

13.3.2 Appletsand applications

A number of classes are provided to use the plot toolkit classes in common ways, but you should
keep in mind that these classes are by no means comprehensive. Many interesting uses of the plot
package involve writing Java code to create customized user interfaces that include one or more plots.
The most commonly used built-in classes are those in the plotml package, which can read PlotML
files, aswell asthe older textual syntax.

Ptplot 5.2, which shipped with Ptolemy 11 2.0 requires Swing. The easiest way to get Swing is to
install the Java 1.3 (or later) Plug-in, which is part of the JRE and JDK 1.3 installation. Unfortunately,
using the Java Plug-in makes the applet HTML more complex. There are two choices:

1. Usefairly complex JavaScript to determine which browser is running and then to properly select
one of three different waysto invoke the Java Plug-in. This method works on the most different
types of platforms and browsers. The JavaScript is so complex, that rather than reproduce it here,
please see one of the demonstration html files.

2. Usethe much simpler <applet> ...</applet> tag to invoke the Java Plug-in. This method works on
many platforms and browsers, but requires a more recent version of the Java Plug-in, and will not
work under Netscape Communicator 4.7x.

For details about the above two choices, see http://java.sun.com/products/plugin/versions.html.
We document the much simpler <applet> . . . </applet> tag format below

The following segment of HTML is an example:
<APPLET

code = "ptoleny.plot.plotm .Pl ot MApplet"
codebase = "../../.."

archive = "ptol eny/plot/plotnm applet.jar"
width = "600"

hei ght = "400"

>

<PARAM NAME = "background" VALUE = "#f af 0e6" >
<PARAM NAME = "dataurl" VALUE = "plotm Sanmple.txt" >
No Java Plug-in support for applet, see
<a href="http://java. sun. con product s/ pl ugi n/ " ><code>htt p://j ava. sun. conl product s/ pl ugi n/ </ code></ a>
</ APPLET>

To use thisyourself you will probably need to change the codebase and dataurl entries. Thefirst points
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Panel

PlotBox

-... . various

+PlotBox()

+addLegend(dataset : int, legend : String)
+addXTick(label : String, position : double)
+addYTick(label : String, position : double)
+clear(axes : boolean)

+clearLegends()

+deferlfNecessary(action : Runnable)

+export(out : OutputStream)

+exportimage() : Bufferedimage
+exportimage(rectangle : Rectangle) : Bufferedimage

+exportimage(img : Bufferedimage) : Bufferedimage
+illPlot()

+getColor() : boolean
+getColorByName(name : String) : Color
+getGrid() : boolean
+getLegend(dataset : int) : String
+getMaximumsSize() : Dimension
+getMinimumSize() : Dimension
+getPreferredSize() : Dimension
+getTitle() : String

+getXLabel() : String

+getXLog() : boolean

+getXRange() : double[]

+getXTicks() : Vector(]

+getYLabel() : String

+getYLog() : boolean

+getYRange() : double[]

+getYTicks() : Vector]

+print(g : Graphics, format : PageFormat, index : int)
+read(in : InputStream)

+read(line : String)

+resetAxes()

+removelLegend(dataset : int)
+samplePlot()

+setBackground(color : Color)
+setBounds(x : int, y : int, width : int, height : int)
+setButtons(visible : boolean)
+setForeground(color : Color)
+setGrid(grid : boolean)
+setLabelFont(fontname : String)
+setSize(width : int, height : int)
+setTitle(title : String)
+setTitleFont(fontname : String)
+setWrap(wrap : boolean)
+setXLabel(label : String)

+setXLog(log : boolean)
+setXRange(min : double, max : double)
+setYLabel(label : String)

+setYLog(log : boolean)
+setYRange(min : double, max : double)
+write(out : OutputStream)

+write(out : OutputStream, dtd : String)
+write(out : Writer, dtd : String)
+writeData(output : PrintWriter)
+writeFormat(out : Writer)

#_drawPlot(g : Graphics, clearfirst : boolean)

#_help()

#_parseLine(line : String)
#_setPadding(padding : double)
_zoom(x : int, y : int)
_zoomBox(x : int, y : int)
_zoomStart(x : int, y : int)

+exportimage(img : Bufferedimage, r : Rectangle, hints : RenderingHints, transp : boolean) : Bufferedimage|

Plot

-... . various

+Plot()

+addPoint(dataset : int, x : double, y : double, connected : boolean)
+addPointWithErrorBars(ds : int, x : double, y : double, yLow : double, yHigh : double, cnct : boolean)
+clear(dataset : int)

+erasePoint(dataset : int, index : int)

+getConnected() : boolean

+getimpulses() : boolean

+getMarksStyle() : String

+getNumDataSets() : int

+setBars(on : boolean)

+setBars(width : double, offset : double)

+setConnected(on : boolean)

+setConnected(on : boolean, dataset : int)

+setimpulses(on : boolean)

+setimpulses(on : boolean, dataset : int)

+setMarksStyle(style : String)

+setMarksStyle(style : String, dataset : int)

+setPointsPersistence(numPoints : int)

+setReuseDatasets(on : boolean)

+setXPersistence(persistence : double)

#_checkDatasetIndex(dataset : int)

#_drawBar(g : Graphics, dataset : int, x : long, y : long, clip : boolean)

#_drawErrorBar(g : Graphics, dataset : int, x : long, ylow : long, yhigh : long, clip : boolean)
#_drawlmpulse(g : Graphics, dataset : int, x : long, y : long, clip : boolean)

#_drawLine(g : Graphics, dataset : int, startx : long, starty : long, endx : long, endy : long, clip : boolean)
#_drawPlot(g : Graphics, clearfirst : boolean)

#_drawPoint(g : Graphics, dataset : int, x : long, y : long, clip : boolean)

# write(output : PrintWriter)

+zoom(lowx : double, lowy : double, highx : double, highy : double)

#_drawPoint(g : Graphics, set: int, X : long, y : long, clip : boolean)
#_drawPlot(g : Graphics, clear : boolean, drawRect : Rectangle)

#_parseLine(line : String) : boolean

PlotPoint
Runnable
+x : double
EditablePlot +y : double
L Tun0 +yLowEB : double
-_redoStack : Stack +yHighEB : double
-_undoStack : Stack +connected : boolean|
-_editListeners : Vector +er_r0_rBar : boolean
+EditablePlot() +ong|na!X : double
+addEditListener(listener : EditListener) +PlotPoint()

]

+getData(dataset : int) : double[][]

+redo()
+removeEditListener(listener : EditListener) PlotLive
+setEditable(dataset : int)
[undo() -_plotLiveThread : Thread
| -... . various
+addPoints()
. +pause()
Histogram +setButtons(visible : boolean)
+start()
-... . various +stop()
+addPoint(dataset : int, value : double)

+addPoint(dataset : int, x : double, y : double, connected : boolean)
+setBars(width : double, offset : double)

+setBinOffset(offset : double)

+setBinWidth(width : double)

#_checkDatasetindex(index : int)

#_drawBar(g : Graphics, dataset : int, xpos : long, ypos : long, clip : boolean)|

EditListener

+editDataModified(source : EditablePlot, dataset : int)|

FIGURE 13.6. The core classes of the plot package.
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to the root directory of the plot installation (usually, the value of the PT1I environment variable). The
second points to afile containing data to be plotted, plus optional formatting information. The file for-
mat for the data is described in the next section. The applet is created by instantiating the PlotM LA p-
plet class.

The archive entry contains the name of the jar file that contains all the classes necessary to run a
PlotML applet. The advantage of specifying a jar file is that remote users are likely to experience a
faster download because al the classes come over at once, rather than the browser asking for each
class from the server. A downside of using jar filesin appletsis that if you are modifying the source of
Ptplot itself, then you must also update the jar file, or your changes will not appear. A common
workaround isto remove the archive entry during testing.

You can also easily create your own applet classes that include one or more plots. As shown in fig-
ure 13.6, the PlotBox class is derived from JPanel, a basic class of the Java Foundation Classes (JFC)
toolkit, also known as swing. It is easy to place a panel in an applet, positioned however you like, and
to combine multiple panelsinto an applet. PlotApplet is asimple class that adds an instance of Plot.

Creating an application that includes one or more plots is also easy. The PlotApplication class,
shown in figure 13.7, creates a single top-level window (a JFrame), and places within it an instance of
Plot. Thisclassis derived from the PlotFrame class, which provides a menu that contains a set of com-
mands, including opening files, saving the plotted datato afile, printing, etc.

The difference between PlotFrame and PlotApplication is that PlotApplication includes a main()
method, and is designed to be invoked from the command line. You can invoke it using commands like
the following:

java -classpath $PTII ptolemy.plot. PlotApplication args

However, the classes shown in figure 13.7, which are in the plot package, are not usually the ones that
an end user will use. Instead, use the ones in figure 13.8. These extend the base classes to support the
PlotML language, described below. The only motivation for using the base classes in figure 13.7 is to
have adlightly smaller jar file to load for applets.

The classes that end users are likely to use, shown in figure 13.8, include:

* PlotMLApplet: An applet that can read PlotML files off the web and render them.

» EditablePlotMLApplet: A version that allows editing of any data set in the plot.

« HistogramMLApplet: A version that uses the Histogram class to compute and plot histograms.

* PlotMLFrame: A top-level window containing a plot defined by a PlotML file.

« PlotMLApplication: An application that can be invoked from the command line and reads PlotM L
files.

» EditablePlotMLApplication: An extension that allows editing of any data set in the plot.

» HistogramMLApplication: A version that uses the Histogram class to compute and plot histo-
grams.

EditablePlotML Application is the class invoked by the pt pl ot command-line script. It can open plot
files, edit them, print them, and save them.
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13.3.3 Writing applets

A plot can be easily embedded within an applet, although there are some subtleties. The simplest
mechanism looks like this:

public class MyAppl et extends JAppl et {
public void init() {
super.init();
Pl ot nyplot = new Plot();
get Cont ent Pane() . add( mypl ot ) ;

Frame

7

PlotFrame

+plot : Plot

+PlotFrame()

+PlotFrametitle : String)
+PlotFrame(title : String, plot : PlotBox)
+samplePlot()

# _about()

# close()

#_editFormat()

#_export()

#_help()

#_open()

#_print()

# read(input : InputStream, base : URL)
#_save()

#_saveAs()

PlotBox

‘ PlotApplication
Applet

+PlotApplication()

+PlotApplication(title : String)

+PlotApplication(plot : PlotBox, args : String[])
+main(args : String) +init()
#_parseArgs() : int

#_usage() : String

-_plot : Plot
+PlotApplet()

+newPlot() : PlotBox

+plot() : Plot

# read(input : InputStream)
#_setPlotSize(appletWidth : int, appletHeight : int)

Histogram Plot

PlotApplet

EditablePlot PlotLive

PlotLiveApplet

+PlotLiveApplet()

FIGURE 13.7. Core classes supporting applets and applications. Most of the time, you will usethe classesin
the plotml package, which extend these with the ability to read PlotML files.
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com.microstar.xml package

XmlParser

HandlerBase

+parse(systemld : String, publicld : String, stream : InputStream, encoding : String)
+setHandler(handler : XmIHandler)

+charData(chars : char[], offset : int, length : int)
+endDocument()
+endElement(elementName : String)

+startDocument()
+startElement(elementName : String)
+startExternalEntity(systemld : String)

+attribute(name : String, value : String, specified : boolean)

+error(message : String, sysid : String, line : int, column : int)
+resolveEntity(systemld : String, publicld : String) : Object

XmlException

+getMessage() : String
+getSystemld() : String

i

+getLine() : int
+getColumn()

+XmlIException(message : String, systemld : String, line : int, column : int)

PlotBoxMLParser
handler
+PlotML_DTD_1 : String
#_attributes : Hashtable
#_currentCharData : StringBuffer
#_parser : XmlParser
# plot : PlotBox
+PlotBoxMLParser() throws
+PlotBoxMLParser(plot : PlotBox) plot package
+parse(base : URL, input : InputStream)
+parse(base : URL, reader : Reader) PlotBox
+parse(base : URL, text : String)
#_checkForNull(object : Object, message : String) i 7\ PlotApplet
#_currentExternalEntity() : String contigures |
| +_read(input : InputStream)
PlotMLParser
Plot PlotApplication
#_connected : boolean
# currentDataset : int
#_currentPointCount : double configures rmain(args - String[l)
+PlotMLParser() #_about()
+PlotMLParser(plot : Plot) # _read(base : URL, input : InputStream)
#_addPoint(connected : boolean, elementName : String),
PlotMLApplet
EditablePlotMLApplet
+PlotMLApplet()
+EditablePlotMLApplet() #_newParser() : PlotMLParser|
HistgramMLParser
HistogramMLApplet PlotMLApplication
+HistogramMLParser(plot : Histogram)
+HistogramMLApplet() +PlotMLApplication()
EditablePlotMLApplication +PlotMLApplication(args : String[])
+PlotMLApplication(plot : PlotBox, args : String[])
#_newParser() : PlotBoxMLParser

+EditablePlotMLApplication()
+EditablePlotMLApplication(args : String[])
+EditablePlotMLApplication(plot : EditablePlot, args : String[])

HistogramMLApplication

+HistogramMLApplication()
+HistogramMLApplication(args : String[])

+HistogramMLApplication(plot : Histogram, args : String[]),

FIGURE 13.8. UML static structure diagram for the plotml package, a subpackage of plot providing classes
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nyplot.setTitle("Title of plot");

}
}

This places the plot in the center of the applet space, stretching it to fill the space available. To control
the size independently of that of the applet, for some mysterious reason that only Sun can answer, it is
necessary to embed the plot in a panel, as follows:

public class MyAppl et extends JAppl et {
public void init() {
super.init();
Pl ot nyplot = new Plot();
JPanel panel = new JPanel ();
get Cont ent Pane() . add( panel ) ;
panel . add( nypl ot);
nmypl ot . set Si ze( 500, 300);
nmyplot.setTitle("Title of plot");

}
}

The setSize() method specifies the width and height in pixels. You will probably want to control the
background color and/or the border, using statements like:

nmypl ot . set Backgr ound( background col or);
nmypl ot . set Bor der (new Bevel Bor der ( Bevel Bor der. RAI SED) ) ;

Alternatively, you may want to make the plot transparent, which results in the background showing
through:

nmypl ot . set Opaque(fal se);

13.4 PlotML File Format

Plots can be specified as textual data in a language called PlotML, which is an XML extension.
XML, the popular extensible markup language, provides a standard syntax and a standard way of
defining the content within that syntax. The syntax is a subset of SGML, and issimilar to HTML. It is
intended for use on the internet. Plot classes can save data in this format (in fact, the Save operation
always saves data in this format), and the classes in the plotml subpackage, shown in figure 13.8, can
read data in this format. The key classes supporting this syntax are PlotBoxM L Parser, which parses a
subset of PlotML supported by the PlotBox class, PlotM L Parser, which parses the subset of PlotML
supported by the Plot class, and HistogramMLParser, which parses the subset that supports histo-
grams.
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13.4.1 Data organization

Plot datain PlotML hastwo parts, one containing the plot data, including format information (how
the plot looks), and the other defining the PlotML language. The latter part is called the document type
definition, or DTD. This dual specification of content and structure is akey XML innovation.

Every PlotML file must either contain or refer to a DTD. The simplest way to do thisis with the
following file structure:

<?xm version="1. 0" standal one="no"?>
<! DOCTYPE nodel PUBLIC "-//UC Berkel ey//DTD Pl ot M. 1//EN"
"http://ptol emy. eecs. berkel ey. edu/ xm /dtd/ Pl ot M__1. dt d" >

<pl ot >
format comands. . .
dat asets. ..

</ pl ot >

Here, “format commands’ is a set of XML elements that specify what the plot looks like, and
“datasets’ isaset of XML elements giving the data to plot. The syntax for these elementsis described
below in subsequent sections. Thefirst line above isarequired part of any XML file. It asserts the ver-
sion of XML that thisfileis based on (1.0) and states that the file includes external references (in this
case, to the DTD). The second and third lines declare the document type (plot) and provide references
tothe DTD.

The referencesto the DTD aboverefer to a“public’ DTD. The name of the DTD is
-/1'UC Berkel ey//DTD Pl ot M. 1//EN

which follows the standard naming convention of public DTDs. The leading dash “- " indicates that
thisisnot aDTD approved by any standards body. Thefirst field, surrounded by double slashes, in the
name of the “owner” of the DTD, “UC Ber kel ey.” The next field is the name of the DTD, “DTD
Pl ot M. 1" wherethe“1” indicates version 1 of the PlotML DTD. Thefinal field, “EN’ indicates that
the language assumed by the DTD is English.

In addition to the name of the DTD, the DOCTYPE element includes a URL pointing to a copy of
the DTD on the web. If a particular PlotML tool does not have accessto alocal copy of the DTD, then
it findsit at thisweb site. PtPIot recognizesthe public DTD, and usesits own local version of the DTD,
so it does not need to visit thiswebsite in order to open a PlotML file.

An dternative way to specify the DTD is:

<?xm version="1.0" standal one="no"?>
<! DOCTYPE pl ot SYSTEM "DTD | ocati on">

<pl ot >
format comuands. . .
dat asets. ..

</ pl ot >

Here, the DTD location is arelative or absolute URL .

A third alternative is to create a standalone PlotML file that includes the DTD. The result is rather
verbose, but has the general structure shown below:
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<?xm version="1. 0" standal one="yes"?>
<I DOCTYPE pl ot [
DTD i nf or mati on

1>

<pl ot >
format commands
dat aset s

</ pl ot >

These latter two methods are useful if you extend the DTD.

The DTD for PlotML is shown in figure 13.9. This defines the PlotML language. However, the
DTD isnot particularly easy to read, so we define the language below in a more tutorial fashion.

13.4.2 Configuring the axes
The elements described in this subsection are understood by the base class PlotBoxM L Parser.

<title>Your Text Here</title>

The title is bracketed by the start element <titl e> and end element </titl e>. In XML, end ele-
ments are always the same as the start el ement, except for the slash. The DTD for thisissimple:

<! ELEMENT title (#PCDATA)>

This declares that the body consists of PCDATA, parsed character data.
Labelsforthe X and Y axes are similar,

<xLabel >Your Text Here</xLabel >
<ylLabel >Your Text Here</ylLabel >

Unlike HTML, in XML, case isimportant. So the element isxLabel not XLabel .
The ranges of the X and Y axes can be optionally given by:

<xRange m n="m n" nmax="mx"/>
<yRange m n="mi n" nmax="mx"/>

The arguments min and max are numbers, possibly including asign and adecimal point. If they are not
specified, then the ranges are computed automatically from the data and padded slightly so that
datapoints are not plotted on the axes. The DTD for these looks like:

<! ELEMENT xRange EMPTY>
<! ATTLI ST xRange mni n CDATA #REQUI RED
max CDATA #REQUI RED>

The EMPTY means that the element does not have a separate start and end part, but rather has a fina
dash before the closing character “/ >". The two ATTLIST elements declare that min and max
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< ELEMENT pl ot (barGaph | bin | dataset | default | noColor | noGid | size| title | wap | xLabel |
xLog | xRange | xTicks | yLabel | yLog | yRange | yTicks)*>
<! ELEMENT bar Graph EMPTY>
<! ATTLI ST bar G aph wi dth CDATA #| MPLI ED
of f set CDATA #| MPLI ED>
<! ELEMENT bin EMPTY>
<! ATTLI ST bin wi dth CDATA #l MPLI ED
of f set CDATA #| MPLI ED>
<! ELEMENT dataset (m| nove | p | point)*>
<l ATTLI ST dat aset connected (yes | no) #l MPLI ED
marks (none | dots | points | various | pixels) #l MPLIED
nane CDATA #| MPLI ED
stems (yes | no) #l MPLIED>
<! ELEMENT default EMPTY>
<! ATTLI ST default connected (yes | no) "yes"
marks (none | dots | points | various | pixels) "none"
stens (yes | no) "no">
<! ELEMENT noCol or EMPTY>
<! ELEMENT noGrid EMPTY>
<! ELEMENT reuseDat asets EMPTY>
<! ELEMENT si ze EMPTY>
<I ATTLI ST si ze hei ght CDATA #REQUI RED
wi dt h CDATA #REQUI RED>
<! ELEMENT title (#PCDATA)>
<l ELEMENT wrap EMPTY>
<! ELEMENT xLabel (#PCDATA)>
<l ELEMENT xLog EMPTY>
<! ELEMENT xRange EMPTY>
<! ATTLI ST xRange min CDATA #REQUI RED
max CDATA #REQUI RED>
< ELEMENT xTi cks (tick)+>
<! ELEMENT yLabel (#PCDATA)>
<! ELEMENT ylLog EMPTY>
<! ELEMENT yRange EMPTY>
<! ATTLI ST yRange min CDATA #REQUI RED
max CDATA #REQUI RED>
< ELEMENT yTi cks (tick)+>
<! ELEMENT tick EMPTY>
<I ATTLI ST tick | abel CDATA #REQUI RED
position CDATA #REQUI RED>
<l ELEMENT m EMPTY>
<I ATTLI ST m x CDATA #| MPLI ED
y CDATA #REQUI RED
| owError Bar CDATA #| MPLI ED
hi ghError Bar CDATA #| MPLI ED>
<! ELEMENT nove EMPTY>
<! ATTLI ST nove x CDATA #l| MPLI ED
y CDATA #REQU RED
| owEr ror Bar CDATA #l MPLI ED
hi ghErr or Bar CDATA #| MPLI ED>
< ELEMENT p EMPTY>
<I ATTLI ST p x CDATA #| MPLI ED
y CDATA #REQUI RED
| owEr ror Bar CDATA #| MPLI ED
hi ghError Bar CDATA #| MPLI ED>
<! ELEMENT poi nt EMPTY>
<! ATTLI ST poi nt x CDATA #| MPLI ED
y CDATA #REQUI RED
| owEr ror Bar CDATA #l MPLI ED
hi ghErr or Bar CDATA #| MPLI ED>

FIGURE 13.9. The document type definition (DTD) for the PlotML language.
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attributes are required, and that they consist of character data.

The tick marks for the axes are usually computed automatically from the ranges. Every attempt is
made to choose reasonable positions for the tick marks regardiess of the data ranges (powers of ten
multiplied by 1, 2, or 5 are used). However, they can also be specified explicitly using elements like:

<XTi cks>
<tick | abel
<tick | abel

="| abel " position="position"/>
="| abel " position="position"/>

</ xTi cks>

A label is astring that replaces the number labels on the axes. A position is a number giving the loca-
tion of the tick mark along the axis. For example, a horizontal axis for a frequency domain plot might
have tick marks as follows:

<xTi cks>
<tick | abe
<tick | abe

[ ="-Pl" position="-3.14159"/>

I
<tick | abel

I

I

-PI/2" position="-1.570795"/>
0" position="0"/>

Pl /2" position="1.570795"/>
Pl " position="3.14159"/>

<tick | abe
<tick | abe
</ xTi cks>

Tick marks could also denote years, months, days of the week, etc. Therelevant DTD informationis:

<! ELEMENT xTi cks (tick)+>
<l ELEMENT tick EMPTY>
<I ATTLI ST tick | abel CDATA #REQUI RED
posi ti on CDATA #REQUI RED>

The notation (t i ck) + indicates that the xTi cks element contains one or moret i ck elements.
If ticks are not specified, then the X and Y axes can use alogarithmic scale with the following ele-

ments:

<xLog/ >
<yLog/ >

The tick labels, which are computed automatically, represent powers of 10. The log axis facility has a
number of limitations, which are documented in “Limitations” on page 13-24.

By default, tick marks are connected by a light grey background grid. This grid can be turned off
with the following element:

<noGri d/ >

Also, by default, the first ten data sets are shown each in aunique color. The use of color can be turned
off with the element:
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<noCol or/ >

Finally, the rather specialized element

<wr ap/ >

enables wrapping of the X (horizontal) axis, which means that if a point is added with X out of range,
its X value will be modified modulo the range so that it liesin range. This command only has an effect
if the X range has been set explicitly. It is designed specifically to support oscilloscope-like behavior,
where the X value of pointsisincreasing, but the display wraps it around to left. A point that lands on
the right edge of the X range is repeated on the left edge to give a better sense of continuity. The fea
ture works best when points do land precisely on the edge, and are plotted from left to right, increasing
inX.
You can aso specify the size of the plot, in pixels, as in the following example:

<si ze wi dt h="400" hei ght="300">

All of the above commands can also be invoked directly by calling the corresponding public meth-
ods from Java code.

13.4.3 Configuring data

Each data set has the form of the following example

<dat aset name="grades" narks="dots" connected="no" stens="no">
dat a
</ dat aset >

All of the argumentsto the dat aset element are optional. The narre, if given, will appear in alegend
at the upper right of the plot. The mar ks option can take one of the following values:

* none: (the default) No mark is drawn for each data point.

* points: A small point identifies each data point.

« dots: A larger circle identifies each data point.

e vari ous: Each dataset is drawn with aunique identifying mark. There are 10 such marks, so they
will be recycled after the first 10 data sets.

* pixel s: Asingle pixel identified each data point.

The connect ed argument can take on the values “yes’ and “no.” It determines whether successive

datapoints are connected by aline. The default isthat they are. Finaly, the st ens argument, which can

also take on the values “yes’ and “no,” specifies whether stems should be drawn. Stems are lines

drawn from a plotted point down to the x axis. Plots with stems are often called “stem plots.”
TheDTD is:

<!l ELEMENT dataset (m| nove | p | point)*>
<I ATTLI ST dat aset connected (yes | no) #l MPLIED
marks (none | dots | points | various | pixels) #l MPLIED
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name CDATA #l| MPLI ED
stens (yes | no) #l MPLI ED>

The default values of these arguments can be changed by preceding the dat aset elementswith a
def aul t element, asin the following example:

<default connected="no" narks="dots" stems="yes"/>
The DTD for thiselement is:

<! ELEMENT default EMPTY>

<I ATTLI ST default connected (yes | no) "yes"
mar ks (none | dots | points | various | pixels) "none"
stens (yes | no) "no">

If the following element occurs:

<r euseDat aset s/ >

then datasets with the same name will be merged. This makes it easier to combine multiple data files
that contain the same datasets into one file. By default, this capability isturned off, so datasets with the
same name are not merged.

13.4.4 Specifying data
A dataset has the form

<dat aset options>
dat a
</ dat aset >

The dataitself are given by a sequence of elements with one of the following forms:

<poi nt y="yVal ue">

<poi nt x="xVal ue" y="yVal ue">

<poi nt y="yVal ue" | owkrrorBar="|ow' highErrorBar="high">

<poi nt x="xVal ue" y="yVal ue" | owErrorBar="1ow"' highErrorBar="high">

To reduce file size somewhat, they can aso be given as

<p y="yVal ue">

<p x="xVal ue" y="yVal ue">

<p y="yVal ue" | owkrrorBar="1ow" hi ghErrorBar="high">

<p x="xVal ue" y="yVal ue" | owkrrorBar="Iow' highErrorBar="high">

The first form specifiesonly aY value. The X valueisimplied (it is the count of points seen beforein
this data set). The second form gives both the X and Y values. The third and fourth forms give low and
high error bar positions (error bars are use to indicate a range of values with one data point). Points
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given using the syntax above will be connected by linesif the connect ed option has been given value
“yes’ (or if nothing has been said about it).
Data points may also be specified using one of the following forms:

<nove y="yVal ue">

<nmove x="xVal ue" y="yVal ue">

<nove y="yVal ue" | owkrrorBar="1ow' hi ghErrorBar="hi gh">

<nmove x="xVal ue" y="yVal ue" | owErrorBar="1ow" hi ghErrorBar="high">

<m y="yVal ue" >

<m x="xVal ue" y="yVal ue">

<m y="yVal ue" | owkrrorBar="1ow' highErrorBar="hi gh">

<m x="xVal ue" y="yVal ue" | owErrorBar="1ow" highErrorBar="high">

This causes a break in connected points, if lines are being drawn between points. I.e., it overrides the
connect ed option for the particular data point being specified, and prevents that point from being
connected to the previous point.

13.4.5 Bar graphs

To create a bar graph, use:

<bar Graph wi dt h="barWdt h" of fset="barCOfset"/>

You will also probably want the connect ed option to have value “no.” The bar W dt h isareal num-
ber specifying the width of the bars in the units of the X axis. The bar Of f set isarea number speci-
fying how much the bar of the i-th data set is offset from the previous one. This allows bars to “ peek
out” from behind the ones in front. Note that the front-most data set will be the first one.

13.4.6 Histograms

To configure a histogram on a set of data, use

<bin w dth="bi nWdth" offset="binOfset"/>

The bi nW dt h option gives the width of a histogram bin. |.e., al data values within one bi nW dt h
are counted together. The bi nOf f set value is exactly like the bar Of f set option in bar graphs. It
specifies by how much successive histograms “ peek out.”

Histograms work only on Y data; X dataisignored.

13.5 Old Textual File For mat

Instances of the PlotBox and Plot classes can read asimple file format that specifies the datato be
plotted. Thisfile format predates the PlotML format, and is preserved primarily for backward compat-
ibility. In addition, it is significantly more concise than the PlotML syntax, which can be advanta-
geous, particularly in networked applications.

In this older syntax, each file contains a set of commands, one per line, that essentially duplicate
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the methods of these classes. There are two sets of commands currently, those understood by the base
class PlotBox, and those understood by the derived class Plot. Both classes ignore commands that they
do not understand. In addition, both classes ignore lines that begin with “#’, the comment character.
The commands are not case sensitive.

13.5.1 Commands Configuring the Axes

The following commands are understood by the base class PlotBox. These commands can be
placed in afile and then read via the read() method of PlotBox, or via a URL using the PlotApplet
class. The recognized commands include:

o TitleText: string

e XLabel: string

* YLabel: string

These commands provide atitle and labels for the X (horizontal) and Y (vertical) axes. A string is
simply a sequence of characters, possibly including spaces. There is no need here to surround them
with quotation marks, and in fact, if you do, the quotation marks will be included in the labels.

Theranges of the X and Y axes can be optionally given by commands like:
« XRange: nmin, max
* YRange: nin, max
The argumentsmi n and max are numbers, possibly including asign and adecimal point. If they are not
specified, then the ranges are computed automatically from the data and padded slightly so that
datapoints are not plotted on the axes.

The tick marks for the axes are usually computed automatically from the ranges. Every attempt is
made to choose reasonable positions for the tick marks regardless of the data ranges (powers of ten
multiplied by 1, 2, or 5 are used). However, they can also be specified explicitly using commands like:
e XTicks: label position, |abel position,

e YTicks: label position, |abel position,

Al abel isastring that must be surrounded by quotation marksif it contains any spaces. A positionis
anumber giving the location of the tick mark along the axis. For example, a horizontal axis for a fre-
guency domain plot might have tick marks as follows:

XTicks: -Pl -3.14159, -PI/2 -1.570795, 0 0, PI/2 1.570795, PI 3.14159

Tick marks could also denote years, months, days of the week, etc.

The X and Y axes can use alogarithmic scale with the following commands:
e XLog: on
* YLog: on
Thetick labels, if computed automatically, represent powers of 10. The log axis facility has a number
of limitations, which are documented in “Limitations’ on page 13-24.

By default, tick marks are connected by a light grey background grid. This grid can be turned off
with the following command:

e @Gid: off
It can be turned back on with
e Gid: on
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Also, by default, the first ten data sets are shown each in a unique color. The use of color can be
turned off with the command:
e Color: off
It can be turned back on with
e Color: on

Finally, the rather specialized command

« Wap: on

enables wrapping of the X (horizontal) axis, which means that if a point is added with X out of range,
its X value will be modified modulo the range so that it liesin range. This command only has an effect
if the X range has been set explicitly. It is designed specifically to support oscilloscope-like behavior,
where the X value of pointsisincreasing, but the display wrapsit around to left. A point that lands on
the right edge of the X range is repeated on the left edge to give a better sense of continuity. The fea
ture works best when points do land precisely on the edge, and are plotted from left to right, increasing
inX.

All of the above commands can also be invoked directly by calling the corresponding public meth-
ods from some Java code.

13.5.2 Commandsfor Plotting Data

The set of commands understood by the Plot class support specification of data to be plotted and
control over how the datais shown.

The style of marks used to denote a data point is defined by one of the following commands:
e Marks: none
e Marks: points
* Marks: dots
e Marks: various
e Marks: pixels
Here, poi nt s are small dots, while dot s are larger. If vari ous is specified, then unique marks are
used for the first ten data sets, and then recycled. If pi xel s is specified, then a single pixel is drawn.
Using no marks is useful when lines connect the points in a plot, which is done by default. If the above
directive appears before any DataSet directive, then it specifies the default for all data sets. If it
appears after a DataSet directive, then it applies only to that data set.

To disable connecting lines, use:
e Lines: off
To re-enable them, use
e Lines: on

You can also specify “impulses’, which are lines drawn from a plotted point down to the x axis.
Plots with impulses are often called “stem plots.” These are off by default, but can be turned on with
the command:

* Inmpulses: on

or back off with the command

e Impul ses: off

If that command appears before any DataSet directive, then the command appliesto all data sets. Oth-
erwise, it applies only to the current data set.
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To create a bar graph, turn off lines and use any of the following commands:
e Bars: on
e Bars: width
e Bars: width, offset
Thewi dt h isareal number specifying the width of the barsin the units of the x axis. The of f set isa
real number specifying how much the bar of the i-th data set is offset from the previous one. This
alows bars to “peek out” from behind the ones in front. Note that the front-most data set will be the
first one. To turn off bars, use
e Bars: off

To specify data to be plotted, start a data set with the following command:
« DataSet: string
Here, st ri ng isalabel that will appear in the legend. It is not necessary to enclose the string in quota
tion marks.

To start anew dataset without giving it a name, use:
 DataSet:

In this case, no item will appear in the legend.

If the following directive occurs:
e ReuseDat aSets: on

then datasets with the same name will be merged. This makes it easier to combine multiple data files
that contain the same datasets into one file. By default, this capability isturned off, so datasets with the
same name are not merged.

The dataitself is given by a sequence of commands with one of the following forms:
. X, y
e draw X, y
e nove: X, Yy
* X, Yy, yLowErrorBar, yH ghErrorBar
e draw. X, y, yLowEkrrorBar, yHi ghErrorBar
e nove:. X, Yy, yLowEkrrorBar, yHi ghErrorBar
The dr aw command is optional, so the first two forms are equivalent. The nove command causes a
break in connected points, if lines are being drawn between points. The numbersx and y are arbitrary
numbers as supported by the Double parser in Java (e.g. “1.2", “6.39e-15", etc.). If there are four num-
bers, then the last two numbers are assumed to be the lower and upper vaues for error bars. The num-
bers can be separated by commas, spaces or tabs.

13.6 Compatibility

Figure 13.10 shows a small set of classes in the compat package that support an older ascii and
binary file formats used by the popular pxgr aph program (an extension of xgr aph to support binary
formats). The PxgraphApplication class can be invoked by the pxgraph executable in $PT11/bin. See
the PxgraphParser class documentation for information about the file format.
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13.7 Limitations

The plot package is a starting point, with a number of significant limitations.
* A binary file format that includes plot format information is needed. This should be an extension
of PlotML, where an external entity is referenced.

« If you zoom in far enough, the plot becomes unreliable. In particular, if the total extent of the plot
is more than 232 times extent of the visible area, quantization errors can result in displaying points
or lines. Note that 22 is over 4 billion.

* Thelog axisfacility has a number of limitations. Note that if alogarithmic scale is used, then the
values must be positive. Non-positive values will be silently dropped. Further log axis limita-
tions are listed in the documentation of the _gridinit() method in the PlotBox class.

e Graphs cannot be currently copied via the clipboard.

» Thereisno mechanism for customizing the colors used in a plot.

plot package
PlotApplication
Plot PlotApplet
- +main(args : String[])
+_read(input : InputStream) 4 about()
# parseArgs(args : String[])
# read(base : URL, input : InputStream)
configures
PxgraphParser
PxgraphApplet PxgraphApplication
# plot : Plot
+PxgraphParser(plot : Plot)
+parseArgs(args : String[]) +PxgraphApplet() +PxgraphApplication()
+parseArgs(args : String[], base : URL) +PxgraphApplication(args : String[])
+parsePxgraphargs(args : String[], base : URL) +PxgraphApplication(plot : Plot, args : String[])
+read(input : InputStream)

FIGURE 13.10. The compat package provides compatibility with the older pxgraph program.

13-24 Ptolemy |1



	13 Plot Package
	13.1 Overview
	13.2 Using Plots
	FIGURE 13.1. Result of invoking ptplot on the command line with no arguments.
	13.2.1 Zooming and filling
	FIGURE 13.2. To zoom in, drag the left mouse button down and to the right to draw a box around th...

	13.2.2 Printing and exporting
	FIGURE 13.3. Encapsulated postscript generated by the Export command in the File menu of ptplot c...

	13.2.3 Editing the data
	FIGURE 13.4. You can modify the data being plotted by selecting a data set and then dragging the ...

	13.2.4 Modifying the format
	FIGURE 13.5. You can control how data is displayed using the Format command in the Edit menu, whi...


	13.3 Class Structure
	13.3.1 Toolkit classes
	FIGURE 13.6. The core classes of the plot package.

	13.3.2 Applets and applications
	1. Use fairly complex JavaScript to determine which browser is running and then to properly selec...
	2. Use the much simpler <applet> ...</applet> tag to invoke the Java Plug-in. This method works o...
	FIGURE 13.7. Core classes supporting applets and applications. Most of the time, you will use the...
	FIGURE 13.8. UML static structure diagram for the plotml package, a subpackage of plot providing ...


	13.3.3 Writing applets

	13.4 PlotML File Format
	13.4.1 Data organization
	FIGURE 13.9. The document type definition (DTD) for the PlotML language.

	13.4.2 Configuring the axes
	13.4.3 Configuring data
	13.4.4 Specifying data
	13.4.5 Bar graphs
	13.4.6 Histograms

	13.5 Old Textual File Format
	13.5.1 Commands Configuring the Axes
	13.5.2 Commands for Plotting Data

	13.6 Compatibility
	FIGURE 13.10. The compat package provides compatibility with the older pxgraph program.

	13.7 Limitations


